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Starting Mini-Professional 2000
Once installation is complete, it’s time to start the Mini-Professional 2000 program.
From the Desktop:
• Click on Start.
• Select Programs.
• From there, select Mini-Pro 2000.

When you open Mini-Professional 2000, this sign-on screen appears:

Type in your user name and password, and hit the ENTER key. If your password is not
accepted, and there are asterisks (****) in that area, retype your password over the
asterisks in the password box and hit the ENTER key again. The first time you use the
program, a Registration Expired screen will appears as well, telling you the registration
number has expired. Click OK to open the program.

Note: The Mini-Professional 2000 Program will be registered after you connect to the
FTP site for the first time. Details are in the First-Time Use and Registration section of
this Introduction.
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Using Mini-Professional
Menu Bar
Quick Icon Toolbar

After you have signed on to the program, the main Mini-Professional 2000 screen
appears.
An informational screen appears in the main screen. Here you will find Program
Information, such as serial number and version. Click OK to close this screen.
Along the top of the main screen there are the menu titles: Options, Reports, Utilities,
View, and Exit. Beneath the menu bar on the main screen is a toolbar of icons, or
symbols that allows you to quickly access other screens.

Revision 2.0

4

Basic Mini-Professional 2000 Instructions

Before You Begin
To prevent having trouble getting your work,
check the following setting on your computer:
Go to Start>Settings>Control Panel (or in XP,
Start>Control Panel). Double-click on the
Internet Options folder to open it. Under the
General tab, there is an area called “Temporary
Internet Files”. Click on the Settings button in
that area. The window below will appear.
The options for “Check for newer versions of
stored pages” are listed. Make sure it is set to
“Every visit to the page”.
Click OK at the bottom and exit.

Dial Provider
Each time you use Mini-Pro you will want to connect to your provider to download your
work and pictures. The first time you use Mini-Pro, you will need to connect to
download needed files and register the product. On the main screen, select Options from
the main screen menu bar, and then Dial Provider from the drop-down list that appears.

When you click on the Dial Provider option, the Communications Window appears.
Another way to access this window is to click the Provider button on the quick icon
toolbar.
Click on the Connect button to connect to the provider. The provider is the source of the
work you will download. Once connected, the provider will transmit needed files to your
computer. Once you have downloaded your work you may disconnect from the internet
if it is not set to automatically disconnect.
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Print Tickets
Print a New Ticket

When you select Print New Tickets from the drop-down Options menu on the main
Mini-Professional screen, the Print New Tickets option appears. You may also access
this screen by clicking on the Tickets button on the quick icon toolbar.
This option allows you to print new tickets. The number of new tickets appears in the
middle. You may choose to print, or cancel.
Print a Ticket for an Open Case
To print a ticket for an Open Case, bring the case up on the MiniPro
screen. Click on the File menu title and select the Print Ticket
option.
A window may appear asking you to select the printer you wish to
use. Select the printer and click on the OK button.

Working With Cases
You may bring up a case by Clicking on the Open Item button and typing in the case
number. Or you may click on the Find Item button and double-click on the case you
wish to bring up. Once a case is brought up, you may work with it.
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Using Explorer

When you select Explorer from the Options menu on the Mini-Professional main
screen, the Field Data Explorer screen appears. This screen allows you to easily view
your cases, including status. You may also access this screen by clicking on the Explore
quick icon button. Click on Open or Processing cases in the left area to view a list of
cases.
To view a particular case, click on the “+” sign next to Open or Processing. This will
open up the folder and show the cases that you are working on or have completed. Select
a case and click on it to access case information. To close the folders, click on the “-“
beside the folder name.
Using the Find Item Option

Another way to find a case is to click on the Find Item button. The Status Codes in the
Search Cases window show how a case can be considered New, Open, Processing,
Returned, Need Status, Deleted/Transferred, or Completed. The life cycle of a case is
discussed next.
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The Life Cycle of a Case
New
Open

Processing
Completed

Cases are new until printed.
Cases are open until changed to Processing. An Open Case
changes to Processing if when adding an attachment you have
clicked on the Send All button and answered Yes to Are you done
with this case?. Another way to change an Open Case to
Processing is to click on the Complete Case button under the
case’s Billing/Complete tab. You can change a Processing Case
back to Open by clicking on the Reopen button on the left side of
the case.
A case is in Processing until confirmation of billing is received
from the Manage Professional FTP site. After confirmation is
received, the case is Completed.
After Management Professional has confirmed billing of a case,
the Processing Case is now Completed.

Returned
Returned Cases need more work and are a priority.
Deleted/Transferred A case that has been deleted or transferred and is no longer
assigned to the rep is a Deleted/Transferred Case. These cases will
show up once to alert you to their status, and will be gone.
Need Status
If a status is requested the case will show up here.
Adding a Status
Click on the Status button to the left of the case, and the Status tab will automatically
open with a new status added. Select the Title of the new status from the drop-down list,
and add any comments in the Comments area. If you have an appointment date, you may
click on the calendar and select the date and time. To delete a status, right-click on the
status and select the Delete option.
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Attaching Files and Photos
To attach Word or other files, and photos or sketches to a case, click on the
Attachments/Forms tab at the top of the case.

Click on the Add File button on the right side of the window. Select the location and file
from the window that pops up. It will show up under Attachments as a New file. This
works the same for data files and picture files (please note: a sketch or photo must be
scanned and saved as a file before you will be able to attach it). If you wish, you may
open and view the attached file by double-clicking on the file name.
Hint: When you name files and forms, basic guidelines are to use simple alpha-numeric
names with no characters (~`@#$%^&*(-+=\|[{:;’”<,>.?/) or spaces. If you do need to
separate words, use an underline. For example: file1_photo3.jpg is acceptable. File 1>
photo 3.jpg is not. Try to keep the file names as short as possible by abbreviating some
word—e.g., use “dept” instead of “department”.
Another Hint: If you have loaded photos from your digital camera you may need to
compress these photos before attaching to a case. See the next section on Compressing
Photos for more information.
If you have attached a file by mistake, right-click on the file name and select Delete. A
box appears asking “Do you wish to delete corresponding file?”. Click on NO.
When you have attached all of your files, click on the Send All button on the left side of
the window. A box will appear and ask you “Are you done with this case?” If you
answer No, the case will stay OPEN. If you answer Yes, it will go to PROCESSING.
If a case is in PROCESSING, you may change it back to OPEN by clicking on the
Reopen button to the right of the window.
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Compressing Photos
If you have downloaded photos from your digital camera, they may be too large to attach
to a case. To find out the size, right-click on the picture file and select Properties. The
size should be 75 KB or smaller. If it is larger, you will need to compress it.
You may have a program on your computer that you may use to resize the picture file. If
not, there is a trial version of a program called JPEG Imager that will compress photos.
Downloading the JPEG IMAGER: If you go to the website www.sscg.net, and click on
the Download link, you’ll see a page that has several options. Click on the Download
button next to General Simple Solutions FTP Site. The page that comes up shows
several files. Double click on the jpegcompressor.zip file to download it. Note where it
is being downloaded to so you will be able to find it to install the program.
Once the file is downloaded, find it on your computer and double-click on it to unzip it.
You may have the choice of unzipping more than one file, so select the one that is titled
“setup.exe”. Once it is unzipped you will be able to run the setup file and install JPEG
IMAGER on your computer.
Compressing Your Photos: If you open the JPEG IMAGER, you will see several menu
headings at the top of the window. Click on FILE, and then OPEN. Find the picture you
wish to compress and open it. Click on COMPRESS and then FIT TO FILE SIZE. A
box comes up with some options. Uncheck MIN RATIO and make sure MAX FILE
SIZE is checked. Enter the number 75. This means your photos will be no more than 75
KB (Kilobytes) large. After compressing, Click on FILE and SAVE AS. Name the file
something different—it can be as simple as adding “cmp” to the file name. For example,
if your original file is named “1024_img.jpg”, you might change the name to
“1024_img_cmp.jpg”. This way you know if the file you are attaching is the compressed
one.
On Your Camera: Another hint is to take photos with less resolution and therefore
reduce the original size of the picture file.
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Billing Your Case
If your company wants you to send your billing information with your case in MiniPro,
you may do so by opening the case and clicking on the Bill Case button to the left of the
case screen. This will insert billing into the Billing/Complete tab screen. Enter the hours
into the Qty area, and any other applicable billing information.

The Billing Tab Screen
Save your changes and exit the case. Send the billing information in by clicking on the
Provider button and clicking Connect. Once the billing has been sent in you may view
your billing invoice. If you look in the case’s Billing/Complete tab again, the invoice
number will appear in the Bill# column.
To view or print the invoice,
go up to the top of the MiniPro
program and click on the
Reports menu heading and
select Invoice. Enter the
invoice number into the box
that appears and click on Print.
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When you click on Print the invoice comes up as a preview before printing. If you billed
more than one case at once all of them will be shown on the invoice. Click the Print
button in the Invoice preview to print.

An Invoice Preview
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Frequently Asked Questions
Where did my Open Case go?
If your case is not listed as an Open Case, it could have been changed to Processing,
Completed, or Deleted/Transferred. Click on the Find Item option to search for your
case.
Why didn’t this Open Case print with the rest of the New Tickets?
The case may have been printed and changed from New to Open. You can print an Open
Case by bringing up the case and clicking on File, Print.
How do I upload processing cases? How do I know when I’ve successfully uploaded
work? Once a case is Processing, the next time you connect to the Provider the cases
should automatically upload. Once you’ve received confirmation from the Management
Professional FTP site that the case has been billed, it is a Completed Case.

Updating Minipro
To get the latest updated version of MiniPro, click on the Provider button to bring up the
Communications Window. In the Options menu, select New Version.

A window will appear asking what version you need. Type the version number into the
window. For example, 1.49. Click on OK.
When you exit, you will receive a message asking “Do you wish to run the update? This
will quit the current application”. Say yes and the update will run. If you want to check
to see if your MiniPro has updated, simple check the version number listed in the
Welcome window that appears when you start the program.
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